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Rechtliche Hinweise 
Warnhinweis 

Tritt ein Fehler oder ein falscher Betriebsablauf auf unserem Produkt auf oder benutzerdefinierte 
Programme erweisen sich als fehlerhaft, sollten Schutz- und Sicherheitsstromkreise, etc. für die 
Sicherheit des verwendeten Systems bereitgestellt werden. Überdies sollten im System 
Sicherheitsmaßnahmen gegen Körperverletzungen oder tödliche Unfälle getroffen werden. 

Lesen Sie unbedingt die Datei Readme.text auf der CD-ROM. 

Je nach Einsatzumgebung und Verwendung könnte das Gerät Funktionsstörungen aufweisen. 

Beachten Sie, dass wir keine Garantie für einen reibungslosen Betrieb auf selbst zusammengestellten 
PCs, etc. übernehmen, abgesehen von firmenproduzierten PCs. 

Qualifiziertes Personal 
Das zugehörige Gerät/System darf nur in Verbindung mit dieser Dokumentation eingerichtet und 
betrieben werden. Inbetriebsetzung und Betrieb eines Gerätes/Systems dürfen nur von qualifiziertem 
Personal vorgenommen werden. Qualifiziertes Personal im Sinne der sicherheitstechnischen Hinweise 
dieser Dokumentation sind Personen, die die Berechtigung haben, Geräte, Systeme und Stromkreise 
gemäß den Standards der Sicherheitstechnik in Betrieb zu nehmen, zu erden und zu kennzeichnen. 

Bestimmungsgemäßer Gebrauch von Siemens-Produkten 
Beachten Sie Folgendes: 

WARNUNG  
Siemens-Produkte dürfen nur für die im Katalog und in der zugehörigen technischen Dokumentation 
vorgesehenen Einsatzfälle verwendet werden. Falls Fremdprodukte und -komponenten zum Einsatz 
kommen, müssen diese von Siemens empfohlen bzw. zugelassen sein. Der einwandfreie und 
sichere Betrieb der Produkte setzt sachgemäßen Transport, sachgemäße Lagerung, Aufstellung, 
Montage, Installation, Inbetriebnahme, Bedienung und Instandhaltung voraus. Die zulässigen 
Umgebungsbedingungen müssen eingehalten werden. Hinweise in den zugehörigen 
Dokumentationen müssen beachtet werden. 

Marken 
Alle mit dem Schutzrechtsvermerk ® gekennzeichneten Bezeichnungen sind eingetragene Marken der 
Siemens AG. Die übrigen Bezeichnungen in dieser Schrift können Marken sein, deren Benutzung durch 
Dritte für deren Zwecke die Rechte der Inhaber verletzen kann. 

Haftungsausschluss 
Wir haben den Inhalt der Druckschrift auf Übereinstimmung mit der beschriebenen Hard- und Software 
geprüft. Dennoch können Abweichungen nicht ausgeschlossen werden, so dass wir für die vollständige 
Übereinstimmung keine Gewähr übernehmen. Die Angaben in dieser Druckschrift werden regelmäßig 
überprüft, notwendige Korrekturen sind in den nachfolgenden Auflagen enthalten. 
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2.1 Foreword 
This instruction manual describes installation and operation for the parameter loader of the display 
recorder.  Read it carefully before use. 
 

2.2 Parameter loader for display recorder 
Connect the parameter loader (hereafter referred to as loader) to the display recorder using 
commercially available USB cable or LAN cable, and referencing (uploading), editing, and setting 
(downloading) of each parameter of the display recorder can be made.  Connect USB miniB type 
male connector to the display recorder. 
Note: When program version of PHL (SITRANS R230) is V07L to V10L, available dedicated cable 

(optional) is required to use the loader. 
 

2.3 Contents of package 
The following items are packaged with the product. 

• CD-ROM for installation: 1 
• Instruction manual which is installed to above CD-ROM 
 

2.4 Recommended operating environment 
• Microsoft Windows 2000 or XP. 
• Hard disk with a free capacity of 30 MB or more 
• RAM with 64 MB or more 
• USB port 
• USB cable (USB miniB) 
• LAN port (when provided with Ethernet option) 
• LAN cable (when provided with Ethernet option) 

Note: 1) Operation by the self-made AT compatible machine and the remodeling machine is not 
secured. 

  Trouble might be caused in operation in a part of AT compatible machine or OS. 
 2) Operation by Windows 95/98/Me/NT is not secured. 
 3) When program version of PHL (SITRANS R230) is V07L to V10L, the hardware 

requirements of the loader are as follows. 
• RS-232C serial port (D-sub 9 pin) 
• Communication cable dedicated to parameter loader 
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2.5 Installing the parameter loader for display recorder 
1) If other application software programs are open, terminate all of them. 
2) If the programming loader has been already installed, open “Add/Remove Programs” on 

Control Panel and delete the parameter loader. 
3) Set CD-ROM in the personal computer drive. 
4) Execute “top_page.html” saved at root folder in the CD-ROM 
5) Follow the prompts displayed on the screen. 
6) Please install the main body of the parameter loader. 

A message is displayed, prompting you to verify that “Parameter loader setup is complete”. 
Now, the Parameter Loader installation is completed. 

 

2.6 Installing USB communication driver 
The driver can be installed on Windows XP as follows for example. 

1) Connect the USB port of the display recorder whose power has been turned on and a running 
PC with a USB cable. 

2) The message “Found New Hardware” and then the driver installation wizard appear on 
thecomputer.  Click the [Next] button. 
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3) When the dialog box below is displayed, select [Display a list of the known drivers for this 

device so that I can choose a specific driver] and click the [Next] button. 

 

4) The dialog box below is displayed.  Select [Other Devices] and click the [Next] button. 

 

5) The dialog box below is displayed.  Click [Have Disk]. 
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6) The [Install From Disk] dialog box is displayed.  Click the [Browse] button. 

 

7) The USB driver “OP-U.inf” is automatically stored in the “inf” folder within the install folder 
(“ParameterLoader” for example) of the parameter loader.   
Select the “OP-U.inf” file and then click “Open.” 

 

8) The previous dialog box is displayed again.  Check the path shown under [Copy 
Manufacturer’s Files From:] and click the [OK] button. 

 

9) The dialog box below is displayed.  Check that [Operation Panel USB Driver] is shown 
under [Models:].  Click the [Next] button. 
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10) The driver installation starts. 

 

11) The dialog box below is displayed on completion of installation.  Click the [Finish] button. 
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Recognition of USB Driver 
When the driver has been installed successfully and the display recorder and the computer are 
connected with a USB cable, the [Device Manager] window shows “Operation Panel - Operation 
Panel USB Driver.” 

 

This will disappear when the display recorder and the computer are disconnected. 
If [Other Device] or [?] is shown even while their connection via USB is maintained, the USB driver 
may not be recognized.  If this happens, uninstall the USB driver once and reinstall it. 
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2.7 Uninstalling the parameter loader software for paperless  
recorder 

Follow Windows operation. 
In case of installation of new loader software, you should delete current loader software which 
you use before installation of new loader software. 
 

2.8 Cautions 
When operating the Loader, be careful of the following items: 

• Before starting the display recorder, be sure to assure that the Loader setting is reflected to the 
display recorder. 

• For the communication setting for the display recorder (“Main Unit Set” → “System Setting”), 
the MODBUS communication function should be set to ON.  After the MODBUS 
communication function has been switched from OFF to ON, turn OFF the power once, and 
then turn it ON. 

• The Loader cannot use more than 1 window at the same time. 
If more than 1 window is open, leave only a single window open and close all of other windows 
(this can be checked on the Window menu). 

• The Loader is used for the display recorder only. 
• Initial values on each Loader screen may be different from those of the display recorder main 

unit. 
• Whenever you want to write the setting data on parameter loader into display recorder, please 

return the display of display recorder to Display Mode such as Real Time Trend Screen.  Don’t 
display Parameter Setting Screen, or this loader software may miss to write into the display 
recorder. 

• At this loader, some parameters which do not exist on display recorder may be displayed.  But 
the parameter which doesn’t exist in the display recorder isn’t written. 

• During display recorder is recording or totalizing, it is impossible to write into display 
recorder from this parameter loader. 
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 2 BASIC OPERATION 
 
2.1 Start 

Click “Programs” ⇒ “Parameter Loader” ⇒ “Parameter Loader” from the Start menu. 

 

It is displayed such as following screen. 
Note: Whenever, this screen is for 18th inputs.  It doesn’t depend on the input points. 

 

Table of setting channel display 
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2.2 Table of setting channel display 
The following is the screen when PHL (SITRANS R230) is selected. 

 
 
 

 
 
 

 
(1) Selection the model setting 

Model to be set by parameter loader can be selected. 

 
 

(7) File menu 
(8) Copy the setting value 

(2) Communication setting 

(3) Upload setting value 
from recorder

(4) Download setting 
value to recorder 

(5) Resister setting 
value 

(6) Time setting 
to recorder 

(1) Selection the
model setting 

PHF



 
Display contents and setting range of each model are as tabled below. 

Model 
PHL  

(SITRANS 
R230) 

PHU 
(SITRANS 

R260) 

PHF 
(SITRANS 

R200) 

Channel setting 18 channels 
(ch 1 to 18) 

36 channels 
(ch 1 to 36) 

6 channels  
(ch 1 to 6) 

Math channel setting 12 channels 
(ch 19 to 30) 

36 channels 
(ch 37 to 72) 

0 channels  
(None) 

DI setting 10 16 5 
DO setting 28 38 10 
Display group setting 4 groups 8 groups 1 group 
Channel color setting Provided Provided Not provided 
Bar graph / analog meter selection Provided Provided Not provided 
Message setting Provided Provided Not provided 
Totalize setting Provided Provided Not provided 
F value calculation setting Provided Provided Not provided 
Modbus communication setting Provided Provided Not provided 

 
(2) Communication setting 

The setting on the communication with the display recorder can be made. 
a) Communication 

The communication method with the display recorder can be selected from USB, Ethernet, and 
RS-232C. 
Note: 
1) USB or Ethernet communications cannot be conducted if the program version of PHL 

(SITRANS R230) is V07L to V10L. 
2) RS-232C communications cannot be conducted if the program version of PHL (SITRANS 

R230) is V16L or later.  Note that to conduct Ethernet communications, optional Ethernet 
communication board is necessary. 

 
b) IP Address 

Setting is necessary to conduct Ethernet communications with the display recorder. 
IP Address and Station No. of the display recorder can be set. 
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c) Port 
Setting is necessary to conduct RS-232C communications with the display recorder. 
The communication port of the PC used to communicate with the display recorder can be set. 
This function can change communication port of PC which communicates with display recorder.  
At starting of this loader, COM1 is selected as communication port.  Set the port number that 
you want to use at first.  
At the executing screen, click [Com(R)] — [Port(P)] and select using port.  Normally, COM1 
is selected. 

 
(3) Upload setting value from display recorder 

It is available to upload all the setting such as channel setting, math channel setting, main 
setting, display setting and so on from display recorder. 

(4) Download setting value to display recorder 
It is available to download all the setting such as channel setting, math channel setting, main 
setting, display setting and so on to display recorder. 
Note: 1) Download prohibit during recording or totalizing. 
 2) Be careful that if you don’t register set value, your setting isn’t registered, so when 

you turn off and on the display recorder, setting value returns before you change. 
(5) Resister setting value 

It is available to register setting value to Flash ROM. 
(6) Time setting to display recorder 

It is available to change time setting of display recorder.  Press [Time setting] button, and 
screen as shown below appears.  Set the time that you want to change.  And then press 
[Change] button. 
Note: 1) This setting prohibit during recording or totalizing. 
 2) This setting is not necessary to register set value. 

 
Screen of time setting 



 
(7) File menu 

This menu, you can use functions as shown below. 

 
 

a) Open 
Display recorder parameter setting files stored in your PC can be opened. 
Parameter setting files stored in the display recorder can also be opened. 

b) Save 
Parameters currently being set can be stored in your PC. 
Extension for parameter setting file to be created differs according to model setting. 

When PHL (SITRANS R230) is selected: ******.PHL 
When PHU (SITRANS R260) is selected: ******.PHU 
When PHF (SITRANS R200) is selected: ******.PHF 

Substitute ***** with an arbitrary name.  Select a file name consisting of alphanumeric 
characters with 7 uppercase characters or less when a parameter setting file is to be read from 
a compact flash card to the display recorder. 
Example: 
OK: PARA00.PHL, P123456.PHL NG: Para00.PHL, P1234567.PHL 

c) Text output 
Output setting value as text data.. 
Please refer to attached “Appendix. 1: Example of setting parameters to be printed out.” 

d) Exit 
Exit this menu. 

Note: 1) If you change setting value of recorder, press [Set value register] before exit this 
software, or your setting isn’t registered, so when you turn off and on the recorder, 
setting value returns before you change. 

 2) If you want to use setting value on another day, it is recommended to save the setting 
value file of recorder before exit this software. 
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(8) Copy the setting value 
Copy the setting value such as channel setting, main setting, display setting and so on. 
Click in line of original data and press [Copy].  Click in line that you want to copy., and then 
press [Paste]. 

 
 



 

2.3 Setting channels 
Set the parameter regarding to input, calculation, alarm, display and record of each channel. 
On “Table of setting channel display”, double-click the channel you want to change. 
The following is the screen when PHL (SITRANS R230) is selected for model setting. 

 
 

And then channel setting display appears. 

* Items that can be set differ according to model setting.  
(The above is the screen when PHL (SITRANS R230) is selected for model setting.) 

* Number of channels differs according to model setting. 
 It is available to set till 18ch whichever PHL (SITRANS R230) is 9 or 18 input points. 
 It is available to set till 36ch whichever PHU (SITRANS R260) is 9, 18, 27 or 36 input points. 
 It is available to set till 6ch whichever PHF (SITRANS R200) is 3 or 6 input points. 

* There are some screen to be able to display up to 7 characters as channel tag in spite of setting is 
available up to 8 characters.  So don’t set 8 characters as channel tag. 

* When you set out of the range, message as shown below appears. 

 

Message in recording range 
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* Press [Apply] after changing channel setting, or your setting isn’t registered, so when you turn off 
and on the recorder, setting value returns before you change. 

* When setting model is PHF (SITRANS R200), channel color setting item is not displayed. 
* Basically input type setting is the same for every two channels.   

(1) When changing the input type of channel, setting may be limited by the input type of channel 
just before the selected channel.  

When PHL (SITRANS R230) is selected: 
When PHL (SITRANS R230) is selected, only the same input type as that of the channel 
just before the selected channel can be set for channels 2, 4, 6, 8, 11, 13, 15 and 17. 
However, input type can be selected regardless of other channels for only channels 9 and 
18. 
 

When PHU (SITRANS R260) is selected: 
When PHU (SITRANS R260) is selected, only the same input type as that of the channel 
just before the selected channel can be set for channels 2, 4, 6, 8, 11, 13, 15, 17, 20, 22, 24, 
26, 29, 31, 33 and 35. 
However, input type can be selected regardless of the other channels for only channels 9, 
18, 27 and 36. 
 

When PHF (SITRANS R200) is selected: 
When PHF (SITRANS R200) is selected, only the same input type as that of the channel 
just before the selected channel can be set for channel 5. 
Input type can be selected regardless of other channels for the channels other than channel 5. 

 

Input type is shown as follows: 
Input category Input type 

Thermocouple, 
50 mV 

K-Type TC, E-Type TC, J-Type TC, T-Type TC, R-Type TC, S-Type TC,  
B-Type TC, N-Type TC, W-Type TC, L-Type TC, U-Type TC,  
PN-Type TC, 50 mV 

RTD Pt100Ω, JPt100Ω, Ni100Ω, Pt50Ω, Cu50Ω 
500 mV 500 mV 
5 V 1 to 5 V DC, 0 to 5 V DC 

 



 
For example, when 1-5 V is selected as input type of channel 1 in PHL (SITRANS R230), only 
1-5 V, 0-5 V or Skip can be selected as input type for channel 2 as follows. 
 

 
 
Example: Setting input type of each channel 
 Input type Input group Explanation 
Channel 1 K-Type TC 
Channel 2 T-Type TC 

Thermocouple, 
50 mV 

It is available to set any type of TC or 
50 mV. 

Channel 3 1 to 5 V 
Channel 4 0 to 5 V 

5 V  

Channel 5 Pt100 
Channel 6 JPt100 

RTD It is available to set Pt100Ω or JPt100Ω. 

Channel 7 500 mV 
Channel 8 500 mV 

  

Channel 9 J-Type TC Thermocouple, 
50 mV 

It is available to set any input type to 
channel 9. 

Channel 10 K-Type TC 
Channel 11 50 mV 

Thermocouple, 
50 mV 

It is available to set any type of TC or 
50mV. 

Channel 12 Skip 
Channel 13 1 to 5 V 

5 V 

Channel 14 Pt100 
Channel 15 Skip 

RTD 

Channel 16 Skip 
Channel 17 500 mV 

500 mV 

It is available to set skip under any input 
type. 

Channel 18 50 mV Thermocouple, 
50 mV 

It is available to set any input type to 
channel 18. 
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(2) When input type of channel is changed, initialization of next channel may be required: 

When PHL (SITRANS R230) is selected: 
If PHL (SITRANS R230) is selected, initialization of next channel input type may be 
required when changing the input type for channels 1, 3, 5, 7, 10, 12, 14 and 16. 
 

When PHU (SITRANS R260) is selected: 
If PHU (SITRANS R260) is selected, initialization of next channel input type may be 
required when changing the input type for channels 1, 3, 5, 7, 10, 12, 14, 16, 19, 21, 23, 25, 
27, 30, 32 and 34. 
 

When PHF (SITRANS R200) is selected: 
If PHF (SITRANS R200) is selected, initialization of next channel input type may be 
required when changing the input type for channel 4. 

 
 
When initialization of next channel is required, push “Apply” button to display the next 
message screen. 

 

 
At this screen, if you press [OK] button, the input type of next channel is initialized to the same 
input type of current displayed channel.  In case of 50mV, the next channel becomes K-type 
TC. 
In case of RTD, the next becomes Pt100Ω. 
 



 
* When you set input unit, set ON the “Scaling” at first.  And then press “SELECT” key.   

In case of Thermocouple or RTD input, it is available to select either Celsius or Fahrenheit.  
And the others unit are not displayed. 

 

 

 
 The Unit Select screen appears.  On the screen that is displayed, click a unit and press the 

“Apply” button.  Note that the unit cannot be selected without pressing the “Apply” button. 

 
Example: At voltage input and scaling ON 
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2.3.1 Copying the channel set 
This screen allows you to copy one or more set values from one channel to another. 
Move the cursor to CH on the Table of Setting Channel display, and click it (channel selection). 
Click “Edit” ⇒ “Copy”. 
 
 

 
Move the cursor to CH where you want to paste channel settings and click it (Channel selection).  
Click “Edit” ⇒ “Paste”. 

 
 

 
 
Next, the following message appears, prompting you to select the option. 
Click “OK” when you want to copy the channel setting. 
If the input type is different between current type and new one, display recorder works such as below. 
 
(1) Copying of channel setting in PHL (SITRANS R230) 

1) When copying is made to 1 to 8, and 10 to 17 channels in PHL (SITRANS R230): 
The same input type (*2) is used for the pair channel (*1). 
(*1: 1ch and 2ch, 3ch and 4ch, 5ch and 6ch, 7ch and 8ch, 10ch and 11ch, 12ch and 13ch, 
14ch and 15ch, and 16ch and 17ch are the pair channels.) 

2) When copying is made to 9ch and 18ch: 
Channels other than 9ch and 18ch do not change. 

(2) Copying of channel setting in PHU (SITRANS R260) 
1) When copying is made to 1 to 8, 10 to 17, 19 to 26, and 28 to 35 channels: 

The same input type (*2) is used for the pair channel (*1). 
(*1: 1ch and 2ch, 3ch and 4ch, 5ch and 6ch, 7ch and 8ch, 10ch and 11ch, 12ch and 13ch, 
14ch and 15ch, 16ch and 17ch, 19ch and 20ch, 21ch and 22ch, 23ch and 24ch, 25ch and 
26ch, 28ch amd 29ch, 30 and 31ch, 32ch and 33ch, and 34ch and 35ch are the pair 
channels.) 

Click “Copy”. Select channel. 

Select “Paste”. Select “CH”. 



 
2) When copying is made to 9ch, 18ch, 27ch and 36ch: 

Channels other than 9ch, 18ch, 27ch and 36ch do not change. 
 

(3) Copying of channel setting in PHF (SITRANS R200) 
1) When copying is made to 4ch and 5ch: 

The same input type is used for both 4ch and 5ch. 
2) When copying is made to 1, 2, 3 and 6ch: 

Channels other than 1ch, 2ch, 3ch and 6ch do not change. 
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2.4 Setting math channels 
Set the parameter regarding to formula, calculation, alarm, display and record of each math channel. 
On “Table of setting math channel display”, double click the channel you want to change. 

 
 

And then math channel setting display appears. 
 

* When setting model is PHF (SITRANS R200), math channel setting screen is not displayed. 
* Number of math channels differs according to model setting. 
 When PHL (SITRANS R230) is selected : It is available to set till 12 channels between ch19 and 

ch30. 
 When PHU (SITRANS R260) is selected : It is available to set till 36 channels between ch37 and 

ch72. 
* There are some screen to be able to display up to 7 characters as channel tag in spite of setting is 

available up to 8 characters.  So don’t set 8 characters as channel tag. 
* When you set out of the range, message as shown below appears. 

 

Message in recording range 
* Press [Apply] after changing channel setting, or your setting isn’t registered, so when you turn off 

and on the recorder, setting value returns before you change. 



 
2.4.1 Formula setting  

Please click the [Set] button in the column of formula of Math channel setting to set the formula. 
 

 
 
The Formula setting screen appears.   
 
* Please select the operational expression and the value respectively, push the [OK] button, and fix 

it. 
 
<List of functions that can be used for Formula setting> 

Grammar Operation Explanation 

None No operation Argument is used with no operation performed. 
ABS(A) Absolute value Finds the absolute value of input A. 
POW(A,B) Power Finds the value of input A to “input B”th power. 
SQR(A) Square root Finds the square root of the value of input A. 
LOG(A) Common logarithm Finds the common logarithm of the value of input A. 
LN(A) Natural logarithm Finds the natural logarithm of the value of input A. 
EXP(A) EXP Finds the exponentiation of the value of input A with base “e.” 
RH(A,B) Humidity Finds the relative humidity with input A assumed to represent dry-bulb 

temperature and input B wet-bulb temperature. 
MAX(A,B) Maximum  

(between channels) 
Compares input A and B and finds the larger value. 

MIN(A,B) Minimum  
(between channels) 

Compares input A and B and finds the smaller value. 

H-P(A) Maximum (time) Finds the maximum value of input A within a certain period of time. 
L-P(A) Minimum (time) Finds the minimum value of input A within a certain period of time. 
AVG(A) Average Finds the average value of input A within a certain period of time. 
SUM(A) Summation Finds the sum of input A within a certain period of time. 

 
 
<List of arguments (input) value that can be used for Formula setting> 

Argument Explanation Example 
Channel Input channel C01 
Totalize Totalize channel T01 
DI Digital input D01 
Communication Communication input M01 
Constant Constant K01 
Temporary data Result of previous operation B01 
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2.4.2 Copying the math channel set 
This screen allows you to copy one or more set values from one channel to another. 
Move the cursor to CH on the Table of Setting Channel display, and click it (channel selection). 
Click “Edit” ⇒ “Copy”. 
 
 

 
Move the cursor to CH where you want to paste channel settings and click it (Channel selection).  
Click “Edit” ⇒ “Paste”. 

 
 

 
 
Next, the following message appears, prompting you to select the option. 
Click “OK” when you want to copy the channel setting. 
 

Click “Copy”. Select channel. 

Select “Paste”. Select “CH”. 



 

2.5 Setting the main unit 
This screen allows you to set the recorder main unit. 
Move the cursor to MAIN UNIT on the Table of Setting Channel display, and click it. 

 

 
The Main unit set screen appears. 
* Items that can be set differ according to model setting. (The above is the screen when PHL 

(SITRANS R230) is selected for model setting.) 
* If values are entered over the specified range, the following message appears. 
 

 

 
Alarm Hysteresis message  
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2.5.1 DI function setting (option) 
The DI function allows you to accept the ON/OFF input from external devices connected to external 
terminals.  Number of DI input points differ according to model setting. 
 
 

When PHL (SITRANS R230) is selected: DI1 to DI10 (10 points) 
When PHU (SITRANS R260) is selected: DI1 to DI16 (16 points) 
When PHF (SITRANS R200) is selected: DI1 to DI5 (5 points) 

 
 

Note: 
When PHL (SITRANS R230) is selected: 

DI1-DI5 cannot be used because DI (external control unit) option cannot be provided  
when the input point is 18 points. 
Without the communication function, DI6-DI10 cannot be used. 

When PHU (SITRANS R260) or PHF (SITRANS R200) is selected: 
DI cannot be used if DI (external control unit) option is not provided. 

 



 

2.6 Display setting 
At this screen, you can see or set regarding to screen setting such as structure of screen, trend display 
screen and so on.  Click “Display setting” tab of [Structure of setting channel display]. 

 

 
 

Setting screen appears and you can see status about screen setting. 
* Items that can be set differ according to model setting. (The above is the screen when PHL 

(SITRANS R230) is selected for model setting.) 
* When PHF (SITRANS R200) is selected for model setting, “Analog meter / Bar graph” setting 

item in “Group setting” screen is not displayed. 
 

2.6.1 Display setting 
At this screen, you can set regarding to screen setting such as structure of screen, trend display screen 
and so on.  Double click the group No. at “Display group” column on Display setting screen,  
* Edit the displayed group on “Selected group No.”. 
* Screen name can set to recorder up to 16 characters. 
* If scale display is ON, trend screen is divided in accordance with the scale, not the setting of 

“Display divided”. 
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2.6.2 Setting channels 
Set the structure of screen. 
No.1 at this screen equals to data 1 of “display setting” of recorder, No.2 equals to data 2.  Following 
is the same as above until No.10. 
 

2.6.3 Setting message 
The screen allows you to set messages to be displayed when an event occurs. 
Move the cursor to No. of the Message box on the Main Unit Set screen and double-click it. 

 
 

The Message Setting screen appears. 
 
* When PHF (SITRANS R200) is selected for model setting, setting cannot be made as message 

function is not available. 
 
* Up to 32 characters is available for the message.  The characters exceeding 32 cannot be 

displayed on the recorder main unit. 
 
* After the input of message set data, be sure to press the “Apply” button, or the message cannot be 

registered. 
 
* Message timing is allocated as follows: 

 

 
 
 

Channel No. 
Set alarm No. 

 

 

 
 
 

DI No. 



 
2.6.4 Unit coding 

Units can be made in alphanumerical characters.  This unit can be registered in the input unit when 
scaling is set to ON on the Channel Setting screen. 
Move the cursor to No. of the Unit box on the Main Unit Set screen and double-click it. 

 

The Unit Setting screen appears. 
 

* A message (unit) consisting of up to 7 characters is available for the recording main unit. 
 
* After the input of unit set data, be sure to press the “Apply” button, or the unit cannot be 

registered. 
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2.7 Ethernet communication setting 
Settings related to Ethernet communications such as IP address, user name, operation setting of each 
Ethernet communication function of the display recorder can be checked or made. 
* Ethernet communication function cannot be used unless the display recorder main unit is provided 

with Ethernet communication option. 

 

* Up to 16 characters can be entered as user name. 
* Up to 8 characters can be entered as password. 
* Items that can be set in user level differ according to model setting. 

When PHL (SITRANS R230) or PHF (SITRANS R200) is selected: “Administrator”, “Guest”  
When PHU (SITRANS R260) is selected: “Administrator”, “Engineer”, “Operator”, “Guest” 

 



 

2.8 E-mail communication setting 
Settings related to E-mail communications such as send/receive address and send trigger can be made. 
* E-mail communication function cannot be used unless the display recorder main unit is provided 

with Ethernet communication option. 

 

* Up to 64 characters can be entered as send/receive address. 
* Up to 32 characters can be entered as sender name. 
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2.8.1 E-mail trigger setting 
Other conditions for E-mail transmission can be selected as follows. 
Move the cursor to “E-mail trigger” on the E-mail setting screen and double-click it. 

 

* Up to 32 characters can be entered as the title of E-mail and comments 1 and 2. 
* Be sure to press the [Apply] button to confirm the E-mail trigger setting data that has been entered. 
* E-mail trigger timing is allocated as shown below. 
 
• When sending E-mail by DI operation 

 

• When sending E-mail by alarm operation 

 

DI No. Channel No. 

Alarm No. 
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• When sending E-mail by alarm operation of 
the main unit 

 

• When sending E-mail at fixed intervals 
 

 

Reference time 

Transmission interval Alarm contents 
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FTP server setting
FTP server function     ON              Access control  ON       

Web Server setting
Web server function     ON       

E-mail setting
E-mail function         ON       

MODBUS TCP/IP setting
MODBUS TCP/IP function  ON       

*****E-mail setting*****
SMTP(Mail server) IP address   192  . 198  .   0  .   1  
Sender's mail address         boiler035@test.co.jp                                              
Sender's name                 Boiler035                         

Receiver's mail address
No.1  System-Taro@test.co.jp                                            
No.2  Kiroku-Keiko@test.co.jp                                           
No.3                                                                    
No.4                                                                    
No.5                                                                    
No.6                                                                    
No.7                                                                    
No.8                                                                    

E-mail trigger setting
       Title                              Comment1                           Comment2                          
No.1  Product1 manufacturing beginning   Product1 manufacturing beginning   Boiler035                          
No.2  Boiler035 report at regular time   Report at regular time             Boiler035                          
No.3  The temperature is abnormal!       The temperature is abnormal!       Boiler035                          
No.4                                                                                                           
No.5                                                                                                           
No.6                                                                                                           
No.7                                                                                                           
No.8                                                                                                           
No.9                                                                                                           
No.10                                                                                                          

     Trigger timming  Timming1    Timming2     PV Value   No1 No2 No3 No4 No5 No6 No7 No8
No.1  DI ON         DI2           -               ON        ON  ON  OFF OFF OFF OFF OFF OFF   
No.2  Timer cycle   12hour        -               ON        ON  OFF OFF OFF OFF OFF OFF OFF   
No.3  Alarm ON      channnel1     No.4            ON        ON  ON  OFF OFF OFF OFF OFF OFF   
No.4  None          -             -               OFF       OFF OFF OFF OFF OFF OFF OFF OFF   
No.5  None          -             -               OFF       OFF OFF OFF OFF OFF OFF OFF OFF   
No.6  None          -             -               OFF       OFF OFF OFF OFF OFF OFF OFF OFF   
No.7  None          -             -               OFF       OFF OFF OFF OFF OFF OFF OFF OFF   
No.8  None          -             -               OFF       OFF OFF OFF OFF OFF OFF OFF OFF   
No.9  None          -             -               OFF       OFF OFF OFF OFF OFF OFF OFF OFF   
No.10 None          -             -               OFF       OFF OFF OFF OFF OFF OFF OFF OFF 
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